
  
 

Crystal Reports Designer Version 10 

Exporting to Microsoft Excel 

 

Overview 
This document is intended to assist you in creating or modifying a report in 
Crystal Reports Designer, version 10, that exports successfully to Microsoft 
Excel. 
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Introduction 
This document has three main sections.  

• The first section contains design tips for those who have not yet started (or 
have just begun) to create a report for export to Excel.  

• The second section describes the options of the two Excel exporting 
formats. 

• The third section lists troubleshooting tips for those who have already tried 
exporting to Excel and were not satisfied with the results. 

Report Design Tips for Exporting to Excel 

Background 
Crystal Reports uses an insertion point interface. When you create a report, you 
are placing a series of objects on a page. These objects can be placed anywhere 
on the page. When the object is placed on the report, an XY coordinate is 
assigned to it. This XY coordinate is a measurement from the top left corner of 
the page.  

Microsoft Excel uses a line-by-line interface. A line-by-line interface does not 
allow placement of objects between the lines.  

Therefore, when you export a report, report objects that have been placed 
between lines are moved to the nearest line by the export DLL. When you select 
the report options outlined below, your export to Excel will maintain the column 
and row setup of a worksheet. 

Test how your report will export by placing a few fields on the report and then 
exporting it to Excel. When you are satisfied with the results, add the remaining 
fields to your report. Testing the report as it is created allows you to make the 
necessary design adjustments to the report fields if they are not aligned when 
exported to Excel. 

To achieve best results when exporting to Excel, format the report as closely to 
an Excel spreadsheet as possible.  

Setting Report Options Before You Begin 
When you export a report from Crystal Reports (RPT) format into Microsoft 
Excel (XLS) format, the report’s format may change. To minimize these 
changes, select the following report options. 

Select the report options before you begin building the report. 

1. From the File menu, select Options. 

2. From the Layout tab, select the following check boxes: 
 

Design View Options 

• Select Rulers 
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• Select Guidelines 

• Select Grid 

Preview Options 

• Select Rulers 

• Select Guidelines 

• Select Grid  

Grid Options 

• Select Snap to Grid 

• Clear Free Form Placement 

Placing Objects on the Report 
When you design a report to export to Excel, the report should appear similar to 
the layout of a worksheet. Do not allow the report objects to overlap. Each 
object should represent a cell on an Excel worksheet. 

Minimizing Section Height 
To reduce the occurrence of blank rows in the exported Excel worksheet, 
minimize the height of each section using the Fit Section option.  

Steps to Fit Section 
1. In Design view, right-click the appropriate section on the gray margin to the 

left of the screen. 

2. Click Fit Section.  

Fit Section resizes the section’s bottom border up to the object that has been 
placed at the lowest point in that section. For this reason you should place fields 
at the top of the section to minimize space between the tops of the fields and the 
top of the section. 

NOTE If extra space still appears below the object  after you use Fit Section, resize any objects 
that are more than one line in height. Also, verify that there are no empty text objects at 
the bottom of the section. Use Fit Section again to resize the section’s bottom border. 

Using Guidelines to Align Fields 
How you place database fields on the report affects the layout of the Excel 
worksheet.  

Following the steps below minimizes the layout differences between the original 
report in the Report Designer and the exported worksheet: 

1. Create a guideline. 

• To align all the fields in a row, click the vertical ruler (to the left). 

• To align all the fields in a column, click the horizontal ruler (at the top). 

2. Snap all the report objects to these guidelines.  
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• Click an object, drag it away from the guideline, and then drag it slowly 
back to the guideline.  

• When the object gets close to the guideline it snaps to the line and a red 
mark will appear at the corner of the object.  

• To move the object, click and drag the triangular guideline anchors on the 
appropriate ruler.  

Sizing fields to have the Same Height and Width 
All the fields or text objects that are to appear in the same row in Excel must be 
the same height in the Report Designer. Likewise, all the fields or text objects 
appearing in the same column in Excel must have the same width in the Report 
Designer.  

Minimizing the height of an object and the space between objects without 
allowing the fields to overlap reduces occurrences of blank columns and rows in 
the exported Excel worksheet. 

To set the size of an object in report design, right-click the object and select 
Object Size and Position. 

• Size all the fields and text objects in the same column so they are just wide 
enough and just high enough to accommodate the tallest and longest value 
in the fields or text objects. 

• Base the width of objects on the horizontal length of the data.  

• Use the horizontal and vertical rulers as a reference when specifying height, 
width, and XY coordinates. 

Formatting Fields and Objects Consistently 
Format fields and objects in the same column with the same text justification; 
that is, right-aligned, left-aligned, center-aligned or fully justified. 

1. Select all the fields and objects in a column. 

TIP Click and drag a selection around multiple fields and objects. 

2. Right-click any of the selected items, then click Format Objects. The 
Format Editor dialog box appears. 

3. From the Common tab, select an alignment in the Horizontal Alignment 
box. 

4. Font face, style and size can also affect the width of data on the report, and 
consequently can affect the appearance of the exported worksheet. It is a 
good idea to format fonts consistently. 

5. In the Format Editor dialogue box, click the Font tab. 

6. Select a font, style and size in the corresponding boxes for all the selected 
fields and objects. 

7. Click OK to return to the report. 

Now when you preview the reports, all the fields and text objects display a 
consistent format. 
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Examples of Good and Poor Exports 
The following screen shots show the different results between exporting a report 
designed for export to Excel and one that was not.  

Example A: Good Export 
This example displays a report that has been designed with the techniques and 
suggestions outlined in this document, and the exported result in Excel. 

From Crystal Reports Format 

 
 

To Excel Format 

 
• The report format uses a grid and guidelines to align objects, and all the 

objects in each column have a uniform width and alignment. This ensures 
that columns are aligned and cells have the same alignment in the Excel 
worksheet. 

• There is no spacing between columns. This ensures that no extra columns 
appear in the Excel worksheet. 
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• All objects in each row have the same height. This ensures that no extra 
rows appear in the Excel worksheet. 

 

Example B: Poor Export 
This example displays a report that has not been designed with the techniques 
and suggestions outlined in this document, and the exported result in Excel. 

From Crystal Reports Format 

 

To Exported Excel Format 

 

• The report format does not use a grid and guidelines to align objects, and 
the objects in each column do not have the same width and alignment. 
Therefore, columns are not aligned and cells do not have the same 
alignment in the Excel worksheet. 

• There is extra space between columns. Therefore, extra columns appear in 
the Excel worksheet. 

• Report objects do not have the same height in each row. Therefore, extra 
rows appear in the Excel worksheet. 
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Selecting an Excel Exporting Format 
There are two Excel exporting formats in Crystal Reports Version 10: MS Excel 
97-2000 and MS Excel 97-2000 (data only). 

• MS Excel 97 – 2000 

This format produces a better WYSIWYG (What You See Is What You 
Get) appearance. The exported file will appear more like a Crystal report 
than if exported to Excel 97-2000 (Data only) format. 

• MS Excel 97 – 2000 (Data only) 

This format disregards the report’s appearance and places the objects as best 
as it can in a column and row format. If you want to edit the exported Excel 
spreadsheet, use this format. This format replaces the Excel Extended 
format found in versions previous to CR 9. 

MS Excel 97-2000 Export Options 
When exporting to Excel 97-2000 in CR 10, the following dialog box with these 
default settings appears with export options.  

 

• Column width 

Here you can define the width of the cell in the exported Excel spreadsheet. 
Constant column width (in points) allows you to pick a constant width. 
Column width based on objects in the : bases the width on objects in either the 
whole report (default setting) or in any of the report sections. 

If you use the “Column widths 
based on objects in the :“ option, 

you should base the width on the 
section that has the most critical 

data, often the Details section. 

• Export Page Header and Page Footer  

Here you can define whether objects in the Page Header and Page Footer 
sections are exported and if so whether they will appear once above or 
below each column or appear on each page by selecting None, Once Per 
Report, or On Each Page. 

• Create page breaks for each page  

Select this option if you want to print from Excel and have the same page 
breaks as in Crystal Reports. You won’t see any difference in the normal 
Excel view if this is selected, but you will when you click the File > Print 
Preview in Excel and when printing from Excel. 
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• Convert date values to strings  

Select this option to change a Date or DateTime field in Crystal Reports to a 
General format cell in Excel. If this is not selected, the cell will have a 
Custom format in Excel. 

• Show Gridlines 

Select this option if you want the Excel gridlines between cells to be visible 
upon export. 

• Page Range  

Click either All Pages or specify a page range by clicking the From option 
button.  

MS Excel 97-2000 (Data only) Export Options 
When exporting to Excel 97-2000 in CR 10, the following dialog box appears 

Typical 

with export options: 

report will be exported using the default settings as seen in the picture 
above with the addition of the “Use worksheet functions for summaries” 

 

• 

orted with no formatting applied. Choosing “Minimal” 
lly selects “Use worksheet functions for summaries” from the 

• 

y combination of the following options to be selected. 

• 

-2000 options

The 

and “Maintain column alignment” options. This option allows some editing
of the spreadsheet while preserving some of the report format. 

Minimal 

Data is exp
automatica
Options area and exports using only that option.  

Custom 

Allows an

Column width 

See MS Excel 97
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• 

then formatting options, including Bold, Italics 
 to Excel when exported.   

NOTE 
Fo exporting to Excel, 
refer to the document cr10_exportlimitations.zip at:  

Export object formatting 

If this check box is selected 
and Highlighting will be passed

r more information on which formatting options are supported when 

http://technicalsupport.businessobjects.com

•

 box if you want images such as pictures and OLE Objects 
& Graphs) to export to Excel. 

• 

ns perform Summary 
 totals. 

• 

he position of report objects in your 
ields are placed two inches from the left 

and so 

• in column alignment 

lated fields in different sections in the same 
el.  

he Sales field appears directly 

 the 

•  and Page Footer  

he Page Header and Page Footer. 

• 

ed then only objects that are aligned with the 
n will be exported. 

 Export images 

Select this check
(including Maps 

Use worksheet functions for summaries 

Select this check box to make Excel functio
calculations. This is not applicable to running

Maintain relative object position 

Choose this option to approximate t
report. For example, if your report f
margin of your Crystal report, the exported worksheet may contain several 
empty columns in lieu of the margin space; the data appears after the empty 
columns. Leaving this option disabled will place all report objects of each 
section in a single row.  For example, all report objects in the Report 
Header will appear in one row at the beginning of the spreadsheet, and all 
report objects in Details will appear in another row (for each record), 
on. 
 
Mainta

Select this check box to keep re
column when exporting to Exc

For example, a report has a Company Name field to the left of a Sales field 
in the Details section. A Grand Total of t
below the Sales field in the Report Footer section. If the Maintain column 
alignment check box is cleared, the exported Excel file will show the 
Grand Total of the Sales field under the Company Name field. With this 
box selected, the Grand Total of the Sales field appears correctly under
Sales field in Excel. 

Export Page Header

Select this check box to export objects in t

Simplify page headers  

If this check box is select
bottom of the Page Header sectio
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Troubleshooting Issues with Reports Exported to Excel 
This section lists common issues that are encountered when exporting to Excel 
format, and steps to troubleshoot the issue. 

Blank Rows Appear in Excel  
There are three main causes of blank rows in a worksheet. 

A)   Fields or text objects were placed in the same section but were not 
horizontally aligned using guidelines or the snap-to-grid option.  

To prevent blank rows, use guidelines to align fields:  

• In the Design view of the report, click on the vertical ruler to create a 
guideline. 

• Click the field that needs to be aligned, and drag it to the guideline. The 
field should snap to the guideline and its corners should be highlighted in 
red, indicating that the field is attached to the guideline. 

• If the corners of the field do not turn red, repeat the above steps until the 
field is snapped to the guideline. 

• Set the object’s size and position by right-clicking the field, selecting 
Object Size and Position and then setting the XY coordinates. 

NOTE Use the horizontal and vertical rulers as a reference when specifying height, width, and 
XY coordinates. 

When you export the report to Excel there will be no additional blank rows in 
the section. 

B) Fields of different heights were placed in the same section. 
To prevent blank rows, resize all the fields in the section to the same height: 

1. In the Design view of the report, hold down the Shift key while clicking 
each field, until all the fields (and any other objects) in the section are 
highlighted. 

2. Right-click any of the fields, click Size, and select Same Height. 

Export the report to Excel and there will be no additional blank rows in the 
section. 

C) Sections are formatted with complex conditional suppression formulas. 
To prevent blank rows from conditional suppression formulas: 

• Do not use multiple “If-Then-Else” statements in conditional suppression 
formulas.  

For example: 

if not onfirstrecord then true 

else if {Customer.Country} <> "USA" then 

(if {Customer.City} startswith "b" then true else 
false) 
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else if {Customer.Country} = "USA" then  

(if sum({Customer.Last Year's 
Sales},{Customer.Region}) > 678 then false else 
true) 

else false 

• Do not use shared variables and complex formulas that occur during the 
evaluation of WhilePrintingRecords (also known as 2nd pass formulas).  
 

NOTE WhilePrintingRecords formulas are any formulas that use a function that requires data 
from more than one record. Examples of these are Next, Previous, and any summary 
function.  
 
Such formulas can fail to evaluate during export and can therefore create inconsistent 
results. 

For more information on formula evaluation times, please select (F1) within Crystal, 
and search for keywords “evaluation time functions.”  

Fields Appear in Different Rows 
There are two main reasons for fields to appear in different rows in Excel format 
than in the Report Designer. 

A) Fields in the same section are not vertically aligned 
To prevent fields from appearing in different rows, vertically align fields with 
guidelines: 

1. In the Design view, click the vertical ruler to create a horizontal guideline. 

2. Click one of the fields in the section, and drag it to the horizontal guideline. 
The field should snap to the guideline. When the corners are highlighted in 
red, this indicates the field is snapped to the guideline. 

3. Repeat step 2 until all the fields in the section are snapped to the horizontal 
guideline. 

Export the report to Excel and all the fields in the section will appear in the same 
row. 

B) Fields in the same section do not have the same height 
To prevent fields from appearing in different rows, ensure that all the fields in 
the same section have the same height: 

1. Select all the fields in the section by holding down the Shift key while 
clicking each field, until all the fields are highlighted. 

2. Right-click any of the fields, select Size, and then select Same Height. 

Export the report to Excel and all the fields in the section will appear in the same 
row. 

Fields or Sections do not Conditionally Suppress Correctly 
Complex conditional suppression formulas may not evaluate correctly during 
the export process and therefore can be unreliable.  
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To minimize the chances of your conditional suppression formula failing to 
evaluate, follow these tips: 

1. Avoid using multiple conditional suppression formulas (that is, formulas 
that use multiple “If-Then-Else” statements). 

2. Avoid using shared variables and complex formulas that occur during the 
WhilePrintingRecords evaluation time. 

3. Avoid using functions that refer to page numbers, such as PageNumber, 
TotalPageCount, and Page N of M. References to page numbers cannot be 
converted when exporting to Excel. This occurs because Excel does not 
paginate. Instead, Excel places all the data in one large worksheet. 

Blank Columns Appear  
There are five main causes for extra blank columns to appear in a worksheet. 

A) The Report is formatted with white space between fields. 
Export to Excel 97-2000 format is “What You See Is What You Get” 
(WYSIWYG) so if there are spaces between the fields in the report Excel will 
try to format that space with a blank column.   

To eliminate the blank columns: 

1.    Go to File > Options > Layout > Grid Option: and change the Grid Size 
to 0.050. 

2. Show the grid in the Design tab and zoom in to 200%. 

3. Place fields so that there is only 1 grid point between fields and the left page 
border. 

B) Fields in the same column are not aligned with guidelines or snap-to-
grid 

To prevent blank columns, horizontally align fields with guidelines: 

1.    In Design view, click the vertical ruler to create a vertical guideline. 

2.    Click one of the fields in the section, and drag it to the vertical guideline. 
The field should snap to the guideline. When the corners are highlighted in 
red, this indicates the field is snapped to the guideline. 

3.    Repeat step 2 until all the fields in the section are snapped to the vertical 
guideline. 

4.    Set the object’s size and position by right-clicking the field, selecting 
Object Size and Position and then setting the XY coordinates.  

Use the horizontal and vertical rulers as a reference when specifying height, 
width, and XY coordinates. 

Export the report to Excel and all the fields in the section will appear in the same 
column. Extra blank columns will not appear. 

C) Objects in the same column have different widths 
To ensure that all the objects in the same column have the same width: 
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1. Select all the objects (such as database fields, column header text objects, 
and summaries or subtotals) in the column by holding down the Shift key 
while clicking each field, until all the fields are highlighted. 

2. Right-click any one of the fields, click Size, and then select Same Width. 
This widens all the fields in the column until they are the same width as the 
widest object in the column. 

Export the report to Excel and no extra blank columns will appear in the 
worksheet. 

NOTE Fields that are formatted wider than the actual width of the data can cause blank columns. 
Make sure the field width is just wide enough to display the longest data value. See 
Column width on page 7. 

 

D) Fields and objects in the same column do not have the same text 
alignment 
For example, the column h`eading text object is aligned to the right, while the 
database field is aligned to center. 

To ensure all objects have the same alignment: 

1. Select all the objects (such as database fields, column header text objects, 
and summary or subtotals) in the column by holding down the Shift key 
while clicking each field, until all the fields are highlighted. 

2. Right-click any of the fields, then click Format Objects. The Format Editor 
dialog box appears. 

3. From the Common tab, specify an alignment in the Horizontal Alignment 
box. 

4. Click OK to return to the report. All the objects in the same column now 
have the same alignment. 

Export the report to Excel and there will be no extra blank columns in the 
worksheet. 

E) Fields or objects with different font size and formatting (bold, italics) can 
cause blank columns 
To ensure the same font formatting for all objects in a column: 

1. Select all the objects (such as database fields, column header text objects, 
and summary or subtotals) in the column by holding down the Shift key 
while clicking each field, until all the fields are highlighted. 

2. Right-click any of the fields, then click Format Objects. The Format Editor 
dialog box opens. 

3. From the Font tab, specify a size and format for the object’s font. 

4. Click OK to return to the report. 

Export the report to Excel and there will be no extra blank columns in the 
worksheet. 
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Column Headers are not aligned with the Data 
There are four main reasons for Column headers that are not aligned with the 
data in the exported worksheet: 

A) Fields or objects in the same column are not aligned using vertical 
guidelines or snap to grid 
To prevent fields from appearing in different columns, vertically align fields 
with guidelines: 

1. In Design view, click the horizontal ruler to create a vertical guideline. 

2. Click one of the fields in the section, and drag it to the vertical guideline. 
The field should snap to the guideline. When the corners are highlighted in 
red, this indicates the field is snapped to the guideline. 

3. Repeat step 2 until all the fields or objects in the section are snapped to the 
vertical guideline. 

4. Set the object’s size and position by right-clicking the field, selecting 
Object Size and Position and then setting the XY coordinates.  

Use the horizontal and vertical rulers as a reference when specifying height, 
width, and XY coordinates. 

Export the report to Excel and the column headers will align with the data. 

B) Fields that are not the same width are not aligned in the same column 
To ensure all the objects in the same column have the same width: 

1. Select all the objects (such as database fields, column header text objects, 
and summary or subtotals) in the column by holding down the Shift key 
while clicking each field, until all the fields are highlighted. 

2. Right-click any of the fields, click Size, and select Same Width. This 
widens all the fields in the column until they are the same width as the 
widest object in the column. 

Export the report to Excel and the column headers will align with the data. 

NOTE Fields that are formatted wider than the actual width of the data can cause blank columns. 
Ensure that the field width is just wide enough to display the longest data value. 

 

C) Fields appearing in the same column should have the same text 
alignment (right align, left align or center align) 
To ensure all objects have the same alignment: 

1. Select all the objects (such as database fields, column header text objects, 
and summary or subtotals) in the column by holding down the Shift key 
while clicking each field, until all the fields are highlighted. 

2. Right-click any of the fields, then click Format Objects. The Format Editor 
dialog box opens. 

3. From the Common tab, specify an alignment in the Horizontal Alignment 
box. 

Export the report to Excel and the column headers will align with the data. 
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D) Fields with different font size and formatting (bold, italics) can cause 
data to be misaligned 
To ensure uniform font formatting for all objects in a column: 

1. Select all the objects (such as database fields, column header text objects, 
and summary or subtotals) in the column by holding down the Shift key 
while clicking the fields, until all the fields are highlighted. 

2. Right-click any of the fields, then click Format Objects. The Format Editor 
dialog box opens. 

3. From the Font tab, specify a size and format for the object’s font. 

4. Click OK to return to the report. 

Export the report to Excel and the column headers will align with the data. 

Exported Date Fields Appear as ‘XXXXXXX’  
If using Office 97, install latest Service Release (SR) available from Microsoft.  

Subreports and Cross-Tabs do not appear on the Same Row 
This is by design, as the size of Cross-Tabs and Subreports is dynamic; 
therefore, a separate row is given to these objects so they can expand without 
interfering with the alignment of other fields. 

DISCLAIMER The third party products discussed in this white paper were not fully tested in conjunction 
with Crystal Enterprise prior to its release.  Officially supported Crystal Enterprise 
platforms are listed in the text file Platforms.txt found in the root folder of the Crystal 
Enterprise CD as well as in the Knowledge Base article c2009003 (search for this article 
number at http://support.businessobjects.com/search), which is more current.  

The information in this document is provided as a courtesy to assist our customers with 
the configuration of our product in conjunction with these third party platforms.    

In the event issues arise with an unsupported configuration, there is no escalation 
support; however, they will be considered during the development of the next generation 
of our product. 

 

Finding More Information 
For more information and resources, refer to the product documentation and 
visit the support area of the web site at: www.businessobjects.com. 

 www.businessobjects.com 
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